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chapter 1

Welcome to Mbox
Welcome to the Mbox® USB audio and MIDI 
interface from Avid®.

Mbox provides your USB 2.0-equipped com-
puter with two channels of analog audio input 
and output, two channels of digital audio input 
and output, MIDI In and Out ports, one head-
phone output with front panel level control. 
Mbox includes two professional-quality mic pre-
amps and 24-bit/96 kHz analog-to-digital and 
digital-to-analog converters.

Mbox integrates with Pro Tools® software, and 
is compatible with third-party audio and MIDI 
applications that support the CoreAudio (Mac) 
or ASIO (Windows) standard.

Mbox Features
Mbox provides the following:

• Two channels of analog audio input with 
high-quality microphone preamps and swit-
chable 48V phantom power

• Analog input jacks include two XLR/TRS 
combo-jacks and two 1/4 TS jacks, with 
switchable Mic, Line, and DI levels

• Soft-limit feature on each input

• –20 dB pad available separately on each an-
alog input channel

• Two channels of S/PDIF digital input and two 
channels of S/PDIF digital output
• S/PDIF inputs are available independently, 
in addition to analog inputs 1–2

• S/PDIF outputs are available indepen-
dently, in addition to analog outputs 1–2

• Up to a total of four channels of input, using 
analog and digital inputs simultaneously

• One MIDI In and one MIDI Out port, provid-
ing 16 channels of MIDI input and output 

• Two 1/4-inch TRS analog monitor outputs

• 24-bit A/D and D/A converters, supporting 
sample rates up to 96 kHz

• Low Latency Monitoring (LLM) with adjust-
able balance between input and playback 

• Dim and Mono buttons

• 1/4-inch (TRS) stereo headphone output with 
adjustable level control

• On-board reverb and delay effects (useful for 
monitoring while tracking vocals)

• On-board Tuner

• Multi-function, assignable Soft button

• USB 2.0 High-speed operation

Mbox may not function properly if connected 
to a USB hub. Connect Mbox Mini to a sepa-
rate, dedicated USB port.
Chapter 1: Welcome to Mbox 1
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System Requirements and 
Compatibility
Mbox can be used with a qualified Windows or 
Mac computer running Pro Tools software 8.0.4 
or higher.

Mbox can be also be used with a qualified Mac 
or Windows computer running other Core Au-
dio- or ASIO-compliant applications. 

Mbox hardware drivers must be installed before 
you can connect and use your Mbox.

A DVD drive is required to use the Drivers In-
staller disc (included with your Pro Tools soft-
ware package).

Avid can only assure compatibility and provide 
support for hardware and software it has tested 
and approved. 

For complete system requirements and a list of 
qualified computers, operating systems, hard 
drives, and third-party devices, visit:

www.avid.com/compatibility

For Pro Tools installation instructions, see 
the Pro Tools Installation Guide. 

For Mbox hardware drivers installation in-
structions, see Chapter 3, “Installing and 
Connecting Mbox.” 
Mbox User Guide
Conventions Used in This 
Guide
All of our guides use the following conventions 
to indicate menu choices and key commands:
:

The names of Commands, Options, and Settings 
that appear on-screen are in a different font.

The following symbols are used to highlight 
important information:

Convention Action

File > Save Choose Save from the 
File menu

Control+N Hold down the Control key 
and press the N key

Control-click Hold down the Control key 
and click the mouse button

Right-click Click with the right 
mouse button

User Tips are helpful hints for getting the 
most from your system.

Important Notices include information that 
could affect your data or the performance of 
your system.

Shortcuts show you useful keyboard or 
mouse shortcuts.

Cross References point to related sections in 
this guide and other Pro Tools guides.



About www.avid.com
The Avid website (www.avid.com) is your best 
online source for information to help you get 
the most out of your Pro Tools system. The fol-
lowing are just a few of the services and features 
available. 

Product Registration Register your purchase 
online. 

Support and Downloads Contact Avid Customer 
Success (technical support); download software 
updates and the latest online manuals; browse 
the Compatibility documents for system re-
quirements; search the online Knowledge Base 
or join the worldwide Pro Tools community on 
the User Conference. 

Training and Education Study on your own using 
courses available online or find out how you can 
learn in a classroom setting at a certified 
Pro Tools training center. 

Products and Developers Learn about Avid 
products; download demo software or learn 
about our Development Partners and their 
plug-ins, applications, and hardware. 

News and Events Get the latest news from Avid 
or sign up for a Pro Tools demo.
Chapter 1: Welcome to Mbox 3
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chapter 2

Mbox Hardware Overview

Mbox Front Panel Features
Figure 1 identifies controls, indicators, and input and output ports on the front panel on the Mbox. 
Figure 1.  Mbox front panel 
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Instrument Inputs

Use these 1/4-inch TS inputs are for connecting 
an electric guitar, bass, or other instrument-level 
device. The level for these inputs is controlled 
by the Gain Controls.
Front/Rear Source Selectors

These buttons select either the front panel In-
strument Inputs (TS) or rear panel Mic/Line In-
puts (XLR/TRS combo) for each channel. When 
the button is set to the Out position, the front 
panel Instrument Inputs are active. When the 
button is set to the In position, the rear panel 
Mic/Line Inputs are active.
Chapter 2: Mbox Hardware Overview 5
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Gain Controls/–20dB Pad

These knobs adjust the input gain levels of the 
Mic/Line inputs. Turn the knob clockwise to in-
crease gain, and counter-clockwise to decrease 
gain.

If your input signal is too hot even with the 
Gain knob at a low setting, pull the Gain knob 
out to engage a “pad” that attenuates the signal 
by 20 dB.

Signal/Clip LEDs

These LEDs illuminate green in the presence of 
audio signal, and illuminate red if the input sig-
nal has “clipped” (overloaded) the input of the 
Mbox. Clipping the input can result in audible 
distortion.

Soft-Limit Buttons

These buttons activate the Soft-Limit function, 
applying a smooth, overdriven tape-type limit-
ing to strong input signals on the Instrument, 
Mic, or Line inputs.

+48V Switch and LED (Phantom 
Power)

The +48V switch toggles phantom power on/off 
for all mic input channels. The LED, when lit, 
indicates that 48V phantom power is active on 
the XLR Mic inputs. 
Mbox User Guide
About Phantom Power

Dynamic microphones (such as Shure SM57s or 
M-Audio Aries) do not require phantom power 
to operate, but are not harmed by it. Most con-
denser microphones (like an M-Audio Solaris) do 
require phantom power to operate. 

If you are not sure about the phantom power re-
quirements for your microphone, consult your 
microphone’s documentation or contact the 
manufacturer.

Monitor Level

The Monitor Level knob adjusts the output level 
of the Monitor Output ports.

Dim Button and LED

The Dim Button reduces by 30 dB the output 
volume from both the Monitor Outputs and the 
Headphone Output. When engaged, the Dim 
LED lights.

Mono Button

The Mono Button sums the control room out-
puts to a mono signal (delivering that identical 
signal to both speakers) via the Driver Control 
Panel or the Mbox. When engaged, the Mono 
LED lights.

Although phantom power can be used 
safely with most microphones, it is possible 
to damage some ribbon microphones with 
it. Always turn off phantom power and wait 
at least ten seconds before connecting or dis-
connecting a ribbon microphone.

When using phantom power, the Mbox 
maximum current per microphone is 4 mA.



Checking Phase Relationships

The Mono switch can also be used for a quick 
check of the phase relationship between 
Source 1 and Source 2 inputs.

Guitar Tuner Function

When the Dim Button and the Mono Button are 
pushed at the same time, the Guitar Tuner func-
tion is activated. The Dim and Mono LEDs flash 
between off and on to indicate tuner mode is ac-
tive. When a string is played on a guitar plugged 
into an Instrument Input, the Input 1 Sig-
nal/Clip LED is illuminated red if tuning is too 
low, off when tuning is too high, and green 
when tuning is correct. The Input 2 Signal/Clip 
LED is illuminated red if tuning is too high, off 
when tuning is too low, and green when tuning 
is correct. The Tuner interface is displayed in the 
Software Control panel if the Software Control 
Panel is open.

Front Panel Headphone Output

Use the Headphone Output to connect stereo 
headphones with a 1/4-inch stereo connector. 
The headphone outputs mirror the signal sent 
to the Monitor Outputs.

Headphone Volume

The Headphone Volume knob adjusts the out-
put level of the Headphone port. This output is 
independent of the Monitor Level knob.
Multi Button
(Pro Tools Only)

The Multi Button can be assigned to execute sev-
eral functions in Pro Tools, including Add Track, 
Start/Stop Record, Tap Tempo, Toggle Marker 
Locations, and Save Session. See Chapter 5, “Us-
ing the Multi Button (Pro Tools Only).”

USB LED

The USB LED indicates that the Mbox is receiv-
ing power from its USB connection. Once the 
USB light is on, audio can pass in or out of the 
system.

The USB LED is a power LED, which is also indi-
cates when the unit is powered in stand-alone 
mode. In this mode you can connect a USB cable 
but that cable is connected to a wall outlet in-
stead of a computer (similar to an iPod or 
iPhone).
Chapter 2: Mbox Hardware Overview 7
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Mbox Back Panel Features
Figure 2 identifies each port on the back panel of the Mbox. 
Mbox User Guide
Figure 2.  Mbox back panel
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USB Port

This standard USB connector is used to connect 
a USB 2.0 port on your computer to the Mbox. 
One standard USB cable is included with your 
system. (It is also used to power the unit in 
stand-alone mode.)

In use, the S/PDIF input and output channels are 
available in addition to the four channels of an-
alog audio I/O.

Mic/Line Inputs

Each analog source input channel provides 
combination XLR/TRS on the rear panel. These 
balanced/unbalanced analog audio inputs sup-
port the following input levels:

• Mic (microphone) for XLR inputs

• Line (TRS) for line level signals on TRS or TS 
inputs

On the front panel, the input signal is adjusted 
by the Gain control for each channel and the 
source (rear panel Mic/Line, or front panel In-
strument) is chosen using the Source selectors. 
Mic/Line Input 2 is at the far left (when looking 
at the back panel), and Mic/Line Input 1 is to its 
right. The back panel inputs for Mic/Line Input 
1 and Mic/Line Input 2 are located such that 
they are directly in line with their associated in-
put controls on the front panel. This lets you lo-
cate input jacks more easily when viewing from 
the front of the unit. 

Monitor Outputs

These outputs support balanced TRS, or unbal-
anced TS, 1/4-inch connections. To monitor 
your mix, connect these outputs to a mixing 
board, directly to a monitoring system such as a 
stereo power amp, or another stereo destination.



S/PDIF Digital I/O

The S/PDIF in and out ports are unbalanced two-
conductor phono (RCA) connectors that utilize 
a full 24-bit, two-channel digital data stream.

The Sony/Philips Digital Interface Format 
(S/PDIF) is used in many professional and con-
sumer CD recorders and DAT recorders. To 
avoid RF interference, use 75-ohm coaxial cable 
for S/PDIF transfers and keep the cable length to 
a maximum of 10 meters. 

MIDI I/O

The MIDI In and MIDI Out ports are standard 
5-pin MIDI ports, each providing 16 channels of 
MIDI input and output.
Chapter 2: Mbox Hardware Overview 9
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chapter 3

Installing and Connecting Mbox
To use Mbox with Pro Tools or any other Core-
Audio- or ASIO-compatible applications, you 
must install the Mbox hardware drivers on your 
computer. 

This chapter provides instructions on installing 
the drivers on Mac and Windows, and connect-
ing the Mbox to your computer.

Do not start this procedure with your Mbox 
connected to your computer.

Before installing the hardware drivers, refer 
to the Read Me information included with 
the drivers installer for your device.
To install the drivers and connect the Mbox:

1  Make sure you are logged in as an Administra-
tor for the account where you want to install the 
drivers.

2  Do one of the following:

• Insert the Drivers Installer disc that came 
with your Pro Tools software package into 
your computer. 

– or –

• Download the Mbox drivers installer for 
your computer platform from 
www.avid.com. After downloading, make 
sure the installer is uncompressed (.dmg on 
Mac or .ZIP on Windows).

3  Do one of the following:

• On Mac, locate and double-click 
Avid Mbox.mpkg.

– or –

• On Windows, locate and double-click 
Install Avid Mbox.exe.

4  Follow the on-screen instructions to proceed 
with installation.

5  When installation is complete, click Restart.

For details on Administrator privileges, see 
the documentation for your computer. 
Chapter 3: Installing and Connecting Mbox 11
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6  After the computer has restarted, connect the 
small end of the included USB cable to the USB 
port on Mbox and connect the other end to any 
available USB port on your computer.

 wth

You can now use your Mbox with Pro Tools, or 
with any other CoreAudio- or ASIO-compatible 
application.

If the USB LED on the front panel of the 
Mbox does not illuminate, try unplugging 
the USB cable from the Mbox USB port, and 
plugging it back in. If the USB LED still does 
not illuminate, shut down the computer, 
disconnect Mbox and start the computer. 
Once the computer has fully restarted, 
reconnect Mbox.

Mbox may not function properly if con-
nected to a USB hub. If you need to use a 
hub for other USB peripherals, connect the 
hub to a separate USB port; Mbox must be 
connected to a dedicated port on the com-
puter in order to function properly.

For Pro Tools installation instructions, see 
the Pro Tools Installation Guide. 
Mbox User Guide



chapter 4

Making Studio Connections
This chapter provides step-by-step instructions 
for connecting mics, instruments, mixers, 
headphones, speakers, and other devices to 
Mbox .

Connecting Outputs
To hear audio from Mbox, you need to connect 
headphones or an external sound system (such 
as powered monitors or a home stereo) to Mbox.

Headphone jack on front of Mbox

 1/4-inch
Headphone jack

Headphone level
Connecting Headphones

You can use headphones equipped with a 1/4-
inch stereo jack to monitor your audio.

The Headphone Output mirrors Monitor Out-
put channels 1–2. 

To connect headphones:

1  Connect headphones with a 1/4-inch stereo 
connector (or adapter) to the Headphone jack. 

2  Adjust the volume using the Headphone Vol-
ume knob on the front panel.

The headphone outputs mirror the signal sent 
to the Monitor Outputs.
Chapter 4: Making Studio Connections 13
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Connecting a Sound System

The Monitor Outputs on the back of the Mbox 
support 1/4-inch plugs. These connections can 
be balanced TRS (Tip-Ring-Sleeve) connectors, 
or unbalanced TS (Tip-Sleeve) connectors such 
as those on instrument cables. 

To listen to your to audio, connect these outputs 
to any amplification system: powered speakers, 
a home stereo system, or an audio mixer.

To connect a sound system:

 For stereo monitoring, connect Monitor Out-
puts 1 and 2 to the inputs of your main left and 
right speakers.

To connect to a stereo system:

 When connecting to a stereo system, connect 
the left channel of the stereo (often the white 
plug) to Monitor Output 1, and the right chan-
nel of the stereo (often the red plug) to 
Monitor Output 2. 

Stereo output from the Mbox (back panel)

Home stereo systems often use RCA connec-
tors. You can use an adaptor or a special ca-
ble to convert from the 1/4-inch TRS (Tip-
Ring-Sleeve) connectors used by Mbox to the 
RCA connectors on your home stereo.

Line Out Left

Line Out Right
Mbox User Guide
Audio Inputs
Mbox provides two channels of analog inputs, 
and supports microphones, guitars, keyboards, 
and other types of instruments and devices.

Mbox has two audio input sections, labeled In-
put 1 and Input 2. For stereo inputs, use Input 1 
for the left input, and Input 2 for the right in-
put. 

The two input sections are located so that the 
hardware input jacks line up directly behind 
their corresponding input controls on the front 
panel. This makes it easier to locate channel in-
put connections from the front. 

For information about connecting specific au-
dio sources, see “Connecting a Microphone” on 
page 15, and “Connecting Instruments to the 
Mbox” on page 16.

Inputs on front panel of Mbox

Inputs on rear panel of Mbox

Input 1 Input 2

Input 2 and Input 1



Each Input section has three analog input jacks 
(the Mic and Line are on a single, combo jack): 

Mic For XLR microphone cables.

Line (TRS or TS) For 1/4-inch Tip-Ring-Sleeve or 
Tip-Sleeve cables from keyboards, mixers, and 
other line-level sources.

DI  For 1/4-inch Tip-Sleeve cables from guitar, 
bass, or similar sources.

Front panel analog input connectors

Rear panel analog input connectors

DI (instrument) DI (instrument)

Mic/Line Mic/Line
Connecting a Microphone

Mic Cables and Connectors

Use a microphone with an XLR connector to 
connect the microphone to the Mbox.

The Mbox can only supply power through a mi-
crophone cable with an XLR connector. If you 
are not sure about the phantom power require-
ments for your microphone, refer to your micro-
phone’s documentation or contact the manu-
facturer.

Phantom Power

Some microphones require power to operate. 
This power, called phantom power, is supplied ei-
ther by a battery in the microphone, or by a mic 
preamp in a mixer or audio interface (such as 
Mbox) that can supply power through the mi-
crophone cable. 

Most condenser microphones (such as an 
M-Audio Solaris) require phantom power to op-
erate. Dynamic microphones (such as a Shure 
SM57 or an M-Audio Aries) do not require phan-
tom power to operate, but are not harmed by it. 

XLR connector

Although phantom power can be used 
safely with most microphones, it is possible 
to damage some ribbon microphones with 
it. Always turn off phantom power and wait 
at least ten seconds before connecting a rib-
bon microphone.
Chapter 4: Making Studio Connections 15
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Using a Mic with an XLR Connector

To use a microphone that has an XLR connector:

1  Plug your microphone cable into one of the 
Mic/Line inputs on the back of Mbox.

2  Set the Source to Rear (“in” position) by press-
ing the Source selector on the front of Mbox. 

3  If your microphone requires phantom power, 
make sure the microphone is connected, then 
press the Phantom Power switch (labeled 48V) 
on the front of the Mbox. This switch sends 48V 
to both mic inputs. The 48V LED on the front of 
the Mbox lights when phantom power is being 
supplied.

XLR connector plugged into Input 1

Input 1 Source selector

Phantom Power switch

Input 2 Input 1 
Mic input Mic input

Source selector

Phantom Power switch
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4  On the front of the Mbox, carefully turn the 
Gain control to the right to increase the input 
level of your microphone signal.

5  If the incoming signal is too loud, pull the 
Gain knob out to engage the –20 dB pad. 

Connecting Instruments to 
the Mbox
Mbox provides two input types (DI and Line) for 
instruments. 

DI Input Use the DI (“Direct Inject”) input for 
electric guitars or electric basses.

Line Input Use the Line input for line-level de-
vices, including electronic audio sources such as 
mixers, samplers, keyboards, and synthesizers.

Gain knob for Input 1

Gain



Connecting Electric Guitar or Bass

To use a guitar with Mbox:

1  On the front of the Mbox, plug your guitar ca-
ble into one of the Instrument inputs. 

2  On the front of the Mbox, set the source to 
Front by setting the input channel Source selec-
tor to the Out position (orange band is visible).

3  On the front of the Mbox, carefully turn the 
Gain control to the right to increase the input 
level of your guitar.

Connecting a guitar to the 1/4-inch connector

Source selector and Gain control for Input 1

Input 1 instrument input

Input 1 Gain
(level) control

 
Source selector
Connecting Keyboards and Mixers

To use a keyboard or mixer with Mbox:

1  Plug your keyboard, mixer, or other audio 
source into either the Input 1 or Input 2 Line 
(TRS) inputs on your Mbox. If your source is ste-
reo (such as a stereo keyboard or the stereo out-
put from a mixer), connect the left channel 
(often the white plug) to Input 1, and right 
channel (often the red plug) to Input 2.

2  Set the Source to Rear (“in” position) by press-
ing the Source selector on the front of Mbox.

3  Set your instrument’s volume to its optimal 
level. For example, the optimal level for most 
keyboards is between 80% and 100% of maxi-
mum volume.

4  On the front of the Mbox, carefully turn the 
Gain control to the right to increase the input 
level of your keyboard.

Mbox connections for line-level stereo input source

Source selector and Gain control for Inputs 1 and 2

Input 1
left channel)

Input 2
(right channel)

Input 1 Gain
(level) control

 
Source selector

Input 2 Gain
(level) control

 
Source selector
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Digital Input and Output

Mbox provides digital inputs and outputs for 
S/PDIF-format digital audio. The two channels 
of S/PDIF digital input can be used in combina-
tion with the two analog inputs (for a total of 
four simultaneous input channels). The two 
channels of S/PDIF digital output can be used in 
combination with the two analog outputs (for a 
total of four simultaneous output channels).

Connecting Digital Devices

To connect a S/PDIF device to Mbox:

1  Use two 75-ohm coaxial cables with male RCA 
connectors on both ends (purchased separately). 

2  Connect the device’s S/PDIF output to Mbox’s 
S/PDIF input port, and the device’s S/PDIF input 
to Mbox’s S/PDIF output port.

Using S/PDIF Input

If you are using the S/PDIF input on Mbox with 
a third-party CoreAudio-or ASIO-compliant ap-
plication, use the Mbox Control Panel to config-
ure the input. If you are using Pro Tools, use the 
Hardware Setup dialog in Pro Tools.

To configure Pro Tools for a S/PDIF connection:

1  Choose Setup > Hardware Setup. 

2  Select S/PDIF from the Clock Source pop-up 
menu. 

3  Click OK.

4  On the recording track, select the appropriate 
stereo or mono S/PDIF source from the track In-
put selector. 

Once enabled in the Hardware Setup dialog, the 
S/PDIF inputs become active and passes audio to 
Mbox. 
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To configure Mbox for a S/PDIF connection:

1  Do one of the following:

• On Mac, launch System Preferences 
(Apple menu > System Preferences), then 
double-click Avid Mbox. (You can also 
open the Driver Control Panel from the Ap-
plications menu.)

– or –

• On Windows, choose Start > Control Panel > 
Mbox.

2  In the Control Panel, choose Setup.

3  Select S/PDIF from the Clock Source pop-up 
menu. 



MIDI Connections
The two MIDI ports on Mbox are available to 
any MIDI application on your computer, as long 
as the Mbox hardware drivers are installed.

If you need additional MIDI ports you can add a 
compatible MIDI interface. USB MIDI interfaces 
work effectively with Windows or Mac. Serial 
MIDI interfaces are supported on Windows sys-
tems only.

To connect your MIDI device to Mbox:

1  Connect a standard 5-pin MIDI cable from the 
MIDI Out port of your device to the MIDI In 
port on the back of Mbox.

2  Connect another MIDI cable from the 
MIDI In port of your device to the MIDI Out 
port on the back of Mbox.

Only USB MIDI interfaces are compatible 
with Pro Tools systems for Mac OS X. Mo-
dem-to-serial port adapters and serial MIDI 
devices are not supported.

MIDI connections to Mbox

On Mac OS X, use the Audio Midi Setup 
(AMS) utility to customize the names of your 
MIDI devices.

 
MIDI In MIDI Out
Monitoring MIDI Instruments with 
Mbox

If you have a MIDI instrument that has analog 
outputs, you can connect it to Mbox to monitor 
its output. 

To connect your MIDI instrument for monitoring:

 Connect the MIDI instrument’s audio outputs 
to the Line (TRS) inputs on your Mbox.

Mbox connections for line-level stereo input source

Input 2 Input 1
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chapter 4

Using the Driver Control Panel
The Mbox Driver Control Panel lets you config-
ure settings for your audio interface for use with 
Pro Tools or other audio applications that sup-
port the CoreAudio (Mac) or ASIO (Windows) 
standard.

Several features of Mbox can be accessed directly 
from the Mbox front panel, such as input gain, 
phantom power, and output levels. But there are 
many additional parameters that cannot be ac-
cessed from the front panel. These additional 
features are available to you using the included 
Driver Control Panel application.

For information on configuring applications 
other than for use with your interface, see 
“Using Third-Party Applications” on 
page 37.
To open the Driver Control Panel: 

 On Mac, launch System Preferences (Apple 
menu > System Preferences), then double-click 
Avid Mbox. (You can also open the Driver Con-
trol Panel from the Applications menu.)

– or –

 On Windows, choose Start > Control Panel > 
Mbox.

Mbox Driver Control Panel (Horizontal view shown)

Layout menuPresets menu

Additional 
Functions
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To open the Driver Control Panel from Pro Tools:

1  Choose Setup > Hardware.

2  Click Launch Setup App.

Presets 
The Preset view lets you load and save Mbox Set-
tings files, which contain all settings of the 
Mbox Driver Control Panel. This is useful if 
you'd like to save various configurations so that 
you do not have to manually reconfigure your 
system each time you work on a different type of 
project.

Load Button

The Load Button opens a file browser that lets 
you load a previously saved Settings file.

Save as...

The Save as button opens a file browser that lets 
you save the current settings of the Driver Con-
trol Panel to a Settings file.

Mbox Driver Control Panel launched in a Pro Tools 
session
Mbox User Guide
Layouts
The Layout drop-down menu lets you choose 
what information you would like the Driver 
Control Panel to show, and how you would like 
that information to be displayed. There are four 
layouts to select from:

Horizontal

The Horizontal layout is the default layout. It 
shows all knobs, faders, meters and buttons in a 
layout similar to that of a mixing console. The 
Horizontal layout is used for all the screen cap-
tures in this chapter.

Horizontal (Meters Only)

The Meters Only layout emphasizes pre-fader 
hardware input and software return metering, 
but does not provide access to the stereo mixers.

Mbox Driver Control Panel 
(Horizontal (Meters only) shown)



Vertical

The Vertical layout provides access to all con-
trols and meters in a vertical window. The Verti-
cal layout was designed for compact operation, 
which is convenient if you want to run it along 
with Pro Tools or your other audio application 
(uses far less screen real estate, but provides full 
functionality).

Mbox Driver Control Panel 
(Vertical shown)
Vertical (Meters Only)

The Meters Only layout emphasizes pre-fader 
hardware input and software return metering, 
but does not provide access to the stereo mixers

Mbox Driver Control Panel 
(Vertical (Meters only) shown)
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Additional Functions 
Mbox also features a variety of functions acces-
sible through pop-up menus located at the up-
per-right area of the Control Panel:

• Tuner

• Setup 

• Flow

• About

Tuner 

The Tuner activates the tuner function of Mbox. 
You can also access the tuner by pressing the 
front panel Mono and Dim buttons simultane-
ously. A tuner display appears in the center of 
the Driver Control Panel, and the front panel in-
put meters function as tuning indicators as well. 

When tuning from the front panel, use the in-
put meters (LED ladders). They are red when 
out of tune and green when in tune.
 

Mbox User Guide
Setup

Setup is where you define the hardware settings 
of the Mbox. For example, you can set buffer 
size, sample rate, and clock source. Think of 
Setup as a quick way to customize Mbox behav-
ior.

In the Setup window, the options are grouped in 
the following categories:

Hardware Settings

The parameters in this section of the Control 
Panel govern the operation of the interface 
when it is connected to a computer using a USB 
cable (Hosted Mode).

This section of the Control Panel provides pa-
rameters you can set on your interface when it is 
connected to a computer using a UBS cable.

Setup pop-up menu



Disable Host Control

When you launch Pro Tools, it takes control of 
the Driver Control Panel's first stereo mixer. If 
you want to obtain full manual control of the 
Driver Control Panel, choose this option.

Clock Source

This setting determines the clock source to 
which Mbox is synchronized.

Internal If you are using Mbox by itself (i.e., with-
out other digital devices or an external clock), 
select the Internal option for the interface to 
work properly.

S/PDIF  If you have connected a S/PDIF device to 
your Mbox, select the S/PDIF option. This makes 
Mbox clock to the external device’s clock.

Sample Rate

This drop-down menu sets the sample rate of 
Mbox. Note that when using the interface with 
an ASIO or CoreAudio application, the sample 
rate can also be determined by your audio appli-
cation. This parameter may not be editable from 
within the Mbox Control Panel if your audio ap-
plication is running. In this case, any changes to 
the sample rate must be made through the audio 
application itself. If the application does not 
provide a way to set the sample rate, quit the ap-
plication, then change the sample rate through 
the Mbox Control Panel.

When the sample rate is locked to an external 
digital clock source, the Mbox’s LED is solid 
blue. When the sample rate is set and there is no 
digital clock source detected (or cannot lock to it 

If you want to use the Low Latency Monitor-
ing option of Pro Tools, this option must not 
be checked.
for some reason), the LED blinks. (A message ap-
pears at the bottom of the Hardware Settings 
section stating that: “External clock not de-
tected, Audio Streaming is Disabled.”).

Buffer Size (Windows only)

This menu sets the size of the input and output 
buffers on Mbox.

Buffers are used to help keep audio hardware 
and software running smoothly by processing 
audio in groups of samples rather than one sam-
ple at a time. Due to variations between com-
puter hardware and software, it is impossible to 
recommend a single optimum setting for all sys-
tems. It may be necessary to experiment with 
various settings until you find the best buffer 
size for your system.

The goal of setting a buffer size is to reduce it as 
much as possible without hearing any clicks, 
pops, or other glitches. If the buffer size is too 
small, the computer may not be able to make all 
the required audio calculations on time and you 
may hear pops, clicks, and stuttering in your au-
dio streams. On the other hand, if the buffer size 
is set too high, your computer processes audio 
without incident, but your software may feel 
sluggish and unresponsive. 

To find your system’s optimum buffer size set-
ting, begin with a high setting and gradually re-
duce the size until you begin to hear clicks, 
pops, or other audible glitches in your audio. 
Then, raise the buffer size setting until these 
glitches disappear. You may need to stop play-
ing audio any time you change this setting and 
certain applications require you to re-launch the 
program before the new buffer size settings be-
come active.
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Soft Button Settings

The Mbox has four “Soft” buttons: Multi, +48v, 
Mono, and Dim.

Hold Duration

This pop-up menu gives you four choices of 
Press and Hold duration for all soft buttons on 
the front of the Mbox. Choose between 
250 msec, 500 msec, 750 msec, and 1 sec.

Use Dim LEDs for Button off State

Checking this option gives you a dim LED for all 
the soft buttons that are off (so you can still dis-
cern the LED in the dark).

Driver Control Panel Options

Hold Clipping Indicators until Clicked

The top section of the meters (or right section 
for horizontal meters) of the Driver Control 
Panel feature a red clipping indicator. When this 
option is selected, the clipping indicators re-
main lit until they are clicked.

Load Latency and Clock Settings from Settings 
Files

When this option is selected, the clock source 
and buffer settings are recalled when loading a 
setting file

This menu only appears on Windows sys-
tems. Most Mac OS X applications allow to 
change the buffer size from within the au-
dio application itself. Please see your audio 
application’s user guide to learn how to 
change this setting.
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Post-Fader Meters

When this option is selected, fader positions af-
fect the meters. Post-Fader Meters mean the me-
ter indicate post-fader levels.

Pre-Fader Meters

When this option is selected, the meters display 
the level of a signal before it passes the fader. 
This allows signal levels to be displayed regard-
less of the fader positions within the stereo mix 
(in other words, a fader can be all the way down 
and no sound is heard from the mixer’s output, 
but you can still see if there is any activity on 
that input).



FX Sends Mode

Pre-Fader FX Sends

When Pre-Fader FX Sends is selected, the full au-
dio signal is be sent to the FX Sends, regardless 
of the position of the Channel Faders of stereo 
mix 1–2.

Post-Fader (Mix 1/2) FX Sends

When Post-Fader (Mix 1/2) is selected, the audio 
signal level being sent to the FX Sends is affected 
by the position of the Channel Faders of Stereo 
Mix 1.

Flow 

Clicking the Flow pop-up menu opens a display 
showing the signal flow from the inputs to the 
outputs of Mbox. This is a useful reference for 
understanding the path of an audio signal flow-
ing through Mbox.
About 

The About pop-up menu allows you to view the 
firmware version of the Mbox hardware, and the 
package version of the Mbox driver installer.
 

Viewing Firmware and Installer 
Information

Directly above the status indicators, you can 
view the firmware version of the Mbox  hard-
ware, and the package version of the Mbox 
driver installer.

Accessing the Web Links

Along the bottom-right of the Driver Control 
Panel you can easily access helpful online re-
sources on our Avid website (www.avid.com) by 
clicking on the following pop-up menus:

• Manual

• Updates

• Support

• FAQs

• Register

Clicking on any of the “Web links” opens 
your web browser. Your computer must have 
Internet access for these pages to load.

Firmware and driver information Web links
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Stereo Mixes
This 8-input, 4-output mixer allows you to cre-
ate two different stereo mixes from 8 input 
sources consisting of any of the hardware inputs 
(i.e., analog and digital inputs) and software re-
turns (software outputs). This allows you to set 
up near-zero latency cue mixes in which the per-
formers hear a “customized” mix while record-
ing. 

It is important to note that any changes made to 
the stereo mix only affects what is audible from 
the mixer’s outputs—the stereo mix does not af-
fect the signals that are sent to your DAW for re-
cording. For example, if you are recording a vo-
calist and he/she tells you to turn up the vocal 
track so they can hear themselves better, you 
can increase the vocalist’s microphone channel 
in the stereo mix. This makes the vocal part 
louder in the vocalist’s headphones, but it is still 
recorded into your DAW at the volume deter-
mined by the front panel Gain Adjustment 
Knob.

The stereo is set up like a standard mixing con-
sole: There are 8 input channels, each with its 
own volume fader, pan and aux send knobs, 
solo, and mute buttons, as well as a master out-
put section with its own faders and mute but-
ton.

A pair of channels can be linked together by 
clicking the link icon between the two channels. 
Linking channels allows you to adjust mute, 
solo, and fader settings simultaneously by mod-
ifying parameters on either one of the linked 
channels. However, linking two channels does 
not have any effect on their Pan controls, which 
are always made on a per-channel basis.
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The stereo mix features multi-segment meters to 
show input channel levels (directly above each 
channel) and main mixer output levels (at the 
top right of the mixer). The peak hold indica-
tion time as well as pre/post fader metering op-
eration can be set from the Settings Tab of the 
Control Panel. The clip indicators can be reset 
by clicking on the meter itself.

Keep in mind that setting or adjusting the stereo 
mix does not affect the signal that is recorded 
into your DAW. For example, you’ll still be able 
to record a channel while its corresponding ste-
reo mix channel is muted. You won’t hear the 
part through the stereo mix as it is being re-
corded, but it still records into Pro Tools and 
play back properly.



Using the Stereo Mix Section
The stereo mix section is located in the main view of the Driver Control Panel and is divided into 
four main sections:
• Hardware Inputs
• Software Returns
• Effects
• Master
Signal Meter

Solo

Channel Fader

Channel Label

Pan

Mute

Link

Master

 

Hardware Inputs Software Returns

Effects
Hardware Inputs

The Hardware Inputs section is where the 
Mic/Line and Instrument inputs are monitored, 
as well as the S/PDIF input of Mbox. Hardware 
Inputs 1–2 are the analog inputs, and Hardware 
Inputs 3–4 are the S/PDIF input L/R.
Software Returns

The Software Returns section is where the audio 
coming back from Pro Tools (or other audio ap-
plication) is monitored. Software Returns 1 and 
2 is the default stereo output from Pro Tools.
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Pan

The Pan knobs control the position of a chan-
nel’s audio signal in the stereo image of the ste-
reo mix (double-click the knob to return pan to 
center).

Solo

Each Solo button lets audio be monitored for the 
channel of which it is a part, while simultane-
ously muting all other Hardware Input channels 
and Software Returns (except for those that also 
have their Solo buttons activated).

Mute

The Mute buttons are used to individually turn 
off audio monitoring for each channel in the 
stereo mix.

Channel Faders 

The Channel Faders control the monitoring vol-
ume level of each channel in the stereo mix.

Channel Labels 

By default, the Channel Labels show the input 
name of each channel (1–8), except for the Mas-
ter fader pair (which is labeled L/R by default).

Clicking on a Channel Label gives you a cursor, 
allowing you to type in your own custom chan-
nel name (such as “guitar,” “vocals,” etc.).

The Channel Labels also display the signal level 
(in dB) while a fader is being adjusted.
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Link

The Link buttons connect stereo pairs of knobs 
or faders (and also links the corresponding FX 
Send knobs), so that adjusting either channel 
(left/right) adjusts the other side identically.

Effects

The Effects section is where you set up “send-
and-return” configurations, and select the ef-
fects that you apply to the Hardware Inputs 
and/or Software Returns.

Hardware Input FX Sends 

FX Sends are shared by all Stereo Mixes, unless 
“Post-Fader Stereo Mix 1” is chosen in the Setup 
pop-up menu.

Software Return FX Sends

FX Sends are shared by all Stereo Mixes, unless 
“Post-Fader Stereo Mix 1” is chosen in the Setup 
pop-up menu.

Pan controls are unaffected by linking two 
channels.

Links buttons



FX Returns

These knobs control how much of the Effect au-
dio output is mixed in with the monitor signal 
Master L/R outputs. Unlike sends, FX Returns 
are individually adjustable for each stereo mix.

The Clip LED shows clipping if the input to the 
FX is clipping and if the output is clipping (the 
rest of the meter is just output).

Effect

The Effect drop-down menu is used to select the 
effect to be applied to the Hardware Inputs 
and/or Software Returns. There are five available 
reverb types: Three room reverbs and two hall 
reverbs, delay, and echo. These effects can be 
customized by using the following three con-
trols:

Duration This knob controls decay time (for the 
reverbs) or delay time (for delay and echo).

Feedback This knob controls the number of re-
peats for the delay and echo effects. It does not 
affect the reverbs.

Volume This knob controls the effects output 
level being sent to the FX Returns.
Master

The Master section is for monitoring the main 
mixer output. This output can be routed to any 
hardware output. Each Stereo Mix includes mas-
ter section with several controls:

Master Fader Adjusts the overall level of the ste-
reo mix.

Balance Knob Adjusts the left/right balance of 
the stereo mix (double-click the knob to return 
it to center).

Width Knob Adjusts the width of the stereo im-
age, where fully counter-clockwise is mono, and 
fully clockwise is full stereo (double-click the 
knob to return it to center).

Mute Buttons Mutes the left and/or right side of 
the stereo mix.

Master fader

Channel Fader

Balance knob

Swap button

Stereo Mix
Copy pull-on

Width knob

Mute button (L) Mute button (R)
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Swap Button Swaps the stereo image, making the 
left channel play out the Right output, and the 
right channel play out the Left output.

Link Button Links the FXReturns section and the 
mute buttons.

Master Meters Lets you have a visual representa-
tion of the audio signal being fed to the associ-
ated hardware output pair.

Stereo Mix Copy Lets you copy the settings of the 
current stereo mix to one of the other stereo 
mixes.

Status Indicators

Along the bottom-left of the Driver Control 
Panel are the following status indicators:

Hardware Connected

This tells you the status of the hardware; if a 
properly installed, powered-on Mbox is con-
nected to the computer.
 

Streaming

This indicates if audio from an audio applica-
tion (such as Pro Tools) or a media player such as 
Windows Media Player) is currently streaming 
audio to the Mbox.

Host Control Enabled

If an application such as Pro Tools has control 
over the Driver Control Panel, then “Host Con-
trol Enabled” is displayed.

Status indicators
Mbox User Guide



chapter 5

Using the Multi Button (Pro Tools Only)
The Multi button on the front panel of the 
Mbox can be assigned to easily execute several 
functions in Pro Tools including (but not lim-
ited to):

• Add Track

• Start/Stop Record

• Tap Tempo

• Locating to Next/Previous Marker 

• Save Session

You can use the Multi button to do these and 
other common tasks with a single button in-
stead of using on-screen menu commands. By 
pressing the Multi button two different ways 
(Press and Release, Press and Hold) you can per-
form two functions with one button. 

Mbox (Multi button shown)

Multi button
Using the Multi Button
In the Hardware Setup dialog, Pro Tools lets you 
set three Multi button parameters for your Mbox 
using the “Multi Button Function” pane. (You 
can also launch the Driver Control Panel from 
here). 

The Multi Button Function includes the follow-
ing options:

Press and Release Displays the options avail-
able for Press and Release mode.

Press and Hold Displays the options available 
for Press and Hold mode.

Duration Gives four time duration options for 
Press and Hold button.

Launch Control Panel Launches Driver Control 
Panel.

For more information on the Driver Control 
Panel, see See Chapter 4, “Using the Driver 
Control Panel.”.
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To use the Multi Button Function pane and 
configure its parameters (example):

1  Launch Pro Tools.

2  Choose Track > New and create 1 Mono audio 
track.

3  Choose Setup > Hardware.

4  From the Press and Release list, select 
Start/Stop Record (the default).

5  From the Press and Hold list, select Add Se-
lected Tracks (the default).

6  From the Hold Duration list, select 500 msec 
(the default).

7  Go to the Edit Window and select the track 
you just created.

8  Press and hold the Multi button for 500 msec, 
then release. A new track is added in Record En-
able mode.

9  Press and immediately release the Multi but-
ton. The track begins recording. 

This is just one example of how easy it is to use 
the Multi button if you want to quickly throw 
down tracks and record. But you can personalize 
the Multi button settings to fit any audio work-
flow that works for you.

Press and Release Options
When you click on the Press and Release list, a 
pop-up menu provides access to the following 
options:

None No function is selected in this mode.

You need to have at least one track avail-
able in a session to use the Add Last Track 
and Add Selected Track functions.
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Add Last Track Adds the last track type that you 
created in the session. Say you have created two 
Audio tracks in a session. It adds another mono 
Audio track.

Add Selected Track Adds whatever tracks that 
you have selected in a session. Say you have se-
lected two Audio tracks in a session. It adds an-
other two Audio tracks.

Cursor to Next Marker Each time the button is 
pressed and released, the transport locates to the 
next marker location.

Cursor to Previous Marker Each time the button 
is pressed and released, the transport locates to 
the previous marker location.

Start/Stop Playback Each time the button is 
pressed and released, it starts/stops playing back 
the session. 

Start/Stop Record Each time the button is 
pressed and released, it starts/stops recording.

Loop Playback Toggle Each time the button is 
pressed and released, the Loop Playback mode is 
toggled between enabled and disabled. 

Undo Each time the button is pressed and re-
leased, it undoes that last operation you per-
formed in Pro Tools. (Same as the Undo com-
mand from the Pro Tools menu)

Save Session Each time the Multi button is 
pressed and released, it saves the session.

Tap Tempo The Multi button can be tapped to 
adjust the session tempo. Tapping tempo causes 
Pro Tools to come out of Conductor mode and 
match its tempo to the tapped tempo. If 
Pro Tools is already in Manual Tempo mode, the 
session automatically adjusts its tempo to match 
the value created by the Tap Tempo function.



Press and Hold Options
When you click on the Press and Hold list, a 
pop-up menu provides access to the following 
options:

None No function is selected in this mode.

Add Last Track Adds whatever the last track type 
was that you created in the session. Say you 
have five types of tracks in your session but the 
most recent track you created was 1 Mono 
Audio Track, in Samples. It adds another 
1 Mono Audio Track, in Samples.

Add Selected Track Adds whatever tracks that 
you have selected in a session. Say you have se-
lected two Audio tracks in a session. It adds an-
other two Audio tracks.

Cursor to Next Marker Each time the button is 
held and released, the transport locates to the 
next marker location.

Cursor to Previous Marker Each time the button 
is held and released, the transport locates to the 
previous marker location.

Start/Stop Playback Each time the button is 
held and released, it starts/stops playing back 
the session. 

Start/Stop Record Each time the button is held 
and released, it starts/stops recording.

Loop Playback Toggle Each time the button is 
held and released, the Loop Playback mode is 
toggled between enabled and disabled. 

Undo Each time the button is held and released, 
it undoes that last operation you performed in 
Pro Tools. (Same as the Undo command from 
the Pro Tools menu)

Save Session Each time the Multi button is held 
and released, it saves the session.
Hold Duration Options
When you click on the Hold Duration list, a 
drop-down menu provides access to the follow-
ing options:

Hold Duration There are four choices of Hold Du-
ration (250 msec, 500 msec, 750 msec, and 1 
sec), which is the amount of time you choose to 
hold the Multi button down in Press and Hold 
mode. The default is 500 msec.
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appendix a

Using Third-Party Applications
The Mbox hardware drivers allow you to use 
third-party CoreAudio-(Mac) or ASIO-(Win-
dows) compliant audio and MIDI applications 
with your Mbox. 

Configuring Mbox for Third-
Party Applications
When using Mbox with third-party applications 
(such as Apple GarageBand), you may be able to 
configure hardware settings through the audio 
preference settings available in that application.

You can also configure your hardware using the 
Control Panel. See Chapter 4, “Using the Driver 
Control Panel.”

For driver installation instructions, see 
Chapter 3, “Installing and Connecting 
Mbox.”
Configuring the Apple Sound 
Preferences
(Mac Only–Required for Using Qualified Pro 
Tools Interface with Apple iTunes or QuickTime 
Player)

To use your Avid Mbox–family hardware with 
certain CoreAudio-compatible playback applica-
tions (such as Apple iTunes or QuickTime 
Player), you need to configure either Sound Pref-
erences or Audio MIDI Setup.

To configure the Apple Sound Preferences:

1  Launch System Preferences (Apple menu > 
System Preferences)

2  Click Sound.

3  Click Output and select your Pro Tools hard-
ware as the device for sound output. 

4  Click Input and select your Pro Tools hardware 
as the device for sound input.

5  Quit System Preferences.
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appendix b

Compliance Information
Environmental Compliance

Disposal of Waste Equipment by Users 
in the European Union

This symbol on the product or its packaging indicates that this 
product must not be disposed of with other waste. Instead, it 
is your responsibility to dispose of your waste equipment by 
handing it over to a designated collection point for the recycling 
of waste electrical and electronic equipment. The separate 
collection and recycling of your waste equipment at the time of 
disposal will help conserve natural resources and ensure that 
it is recycled in a manner that protects human health and the 
environment. For more information about where you can drop 
off your waste equipment for recycling, please contact your 
local city recycling office or the dealer from whom you 
purchased the product.
Proposition 65 Warning

Perchlorate Notice

This product may contain a lithium coin battery. The State of 
California requires the following disclosure statement: 
“Perchlorate Material – special handling may apply, See 
www.dtsc.ca.gov/hazardouswaste/perchlorate.”

Recycling Notice

This product contains chemicals, including lead, 
known to the State of California to cause cancer and 
birth defects or other reproductive harm. Wash hands 
after handling.
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EMC (Electromagnetic 
Compliance)
Avid declares that this product complies with the following 
standards regulating emissions and immunity:
• FCC Part 15 Class B 
• EN 55022 Class B 
• EN 55204 Class B 
• AS/NZS 3548 Class B 
• CISPR 22 Class B 

FCC Compliance for United States

Radio and Television Interference

This equipment has been tested and found to comply with the 
limits for a Class B digital device, pursuant to Part 15 of the 
FCC Rules.

DECLARATION OF CONFORMITY
We, Avid, 2001 Junipero Serra Boulevard
Daly City, CA 94014-3886, USA
650-731-6300
declare under our sole responsibility that the product
Mbox 
complies with Part 15 of FCC Rules.  
Operation is subject to the following two conditions:  
(1) this device may not cause harmful interference, and 
(2) this device must accept any interference received, 
including interference that may cause undesired operation.

Communication Statement
NOTE: This equipment has been tested and found to comply 
with the limits for a Class B digital device, pursuant to Part 
15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses, 
and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause 
harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a 
particular installation.  If this equipment does cause harmful 
interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is 
encouraged to try and correct the interference by one or 
more of the following measures:
• Reorient or locate the receiving antenna.
• Increase the separation between the equipment and 

receiver.
• Connect the equipment into an outlet on a circuit 

different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician 

for help.
Any modifications to the unit, unless expressly approved by 
Avid, could void the user's authority to operate the 
equipment.
Mbox User Guide
Australian Compliance

Canadian Compliance

This Class B digital apparatus complies with Canadian 
ICES-003

Cet appareil numérique de la classe A est conforme à la norme 
NMB-003 du Canada

CE Compliance

(EMC and Safety)

Avid is authorized to apply the CE (Conformité Europénne) 
mark on this compliant equipment thereby declaring conformity 
to EMC Directive 89/336/EEC and Low Voltage Directive 
73/23/EEC.

Safety Compliance

Warning

Avid



Important Safety Instructions

1) Read these instructions.

2) Keep these instructions.

3) Heed all warnings.

4) Follow all instructions.

5) Do not use this equipment near water.

6) Clean only with dry cloth.

7) Do not block any ventilation openings. Install in accordance 
with the manufacturer’s instructions.

8) Do not install near any heat sources such as radiators, heat 
registers, stoves, or other equipment (including amplifiers) 
that produce heat.

9) Do not defeat the safety purpose of the polarized or 
grounding-type plug. A polarized plug has two blades with one 
wider than the other. A grounding type plug has two blades and 
a third grounding prong. The wide blade or the third prong are 
provided for your safety. If the provided plug does not fit into 
your outlet, consult an electrician for replacement of the 
obsolete outlet.

10) Protect power cords from being walked on or pinched 
particularly at plugs, convenience receptacles, and the point 
where they exit from the equipment.

11) Only use attachments/accessories specified by the 
manufacturer.
12) For products that are not rack-mountable: Use only with a 
cart, stand, tripod, bracket, or table specified by the 
manufacturer, or sold with the equipment. When a cart is used, 
use caution when moving the cart/equipment combination to 
avoid injury from tip-over.

13) Unplug this equipment during lightning storms or when 
unused for long periods of time. 

14) Refer all servicing to qualified service personnel. Servicing 
is required when the equipment has been damaged in any way, 
such as power-supply cord or plug is damaged, liquid has been 
spilled or objects have fallen into the equipment, the 
equipment has been exposed to rain or moisture, does not 
operate normally, or has been dropped.

15) For products that are a Mains powered device: 
The equipment shall not be exposed to dripping or splashing 
and no objects filled with liquids (such as vases) shall be 
placed on the equipment. 

Warning! To reduce the risk of fire or electric shock, do not 
expose this equipment to rain or moisture. 

16) For products containing a lithium battery: 
CAUTION! Danger of explosion if battery is incorrectly 
replaced. Replace only with the same or equivalent type. 

17) The equipment shall be used at a maximum ambient 
temperature of 40° C.
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Avid
2001 Junipero Serra Boulevard 
Daly City, CA 94014-3886 USA
Technical Support (USA)
Visit the Online Support Center at 
www.avid.com/support
Product Information
For company and product information, 
visit us on the web at www.avid.com
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